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Introducing the N8201A Performance Downconverter

The Agilent Technologies N8201A performance downconverter down converts a microwave 
signal to an IF signal providing IF output frequencies of 7.5, 21.4, and 321.4 MHz to offer 
three different signal bandwidth capabilities. External mixing can be utilized to down 
convert microwave signals up to 110 GHz. The N8201A is based upon the industry’s most 
accurate spectrum analyzer, the PSA Series.

Agilent's synthetic instrument family offers the highest-performing RF/MW LAN-based 
modular instrumentation and the smallest footprint for automated test systems; providing 
the maximum flexibility and minimizing the cost of an ATS over its lifetime. 

Agilent’s synthetic instrument modules use LAN eXtension for Instrumentation (LXI) 
modular format. LXI differs from other modular formats (such as VXI and PXI) by using an 
external computer and local area network (LAN), rather than embedded computers, for 
control. 

The LXI standard supports the IEEE 1588 time synchronization and protocol standard, which 
allows synchronous triggering of different instruments, even with different-length LAN 
cables. The IEEE 1588 precision time protocol (PTP) enables a common sense of time over a 
distributed system. 

Synthetic instrument modules offered by Agilent Technologies include the following:

• N8201A performance downconverter, 3 Hz to 26.5 GHz

• N8211A performance analog upconverter, 250 kHz to 20 / 40 GHz

• N8212A performance vector upconverter, 250 kHz to 20 GHz

• N8221A IF digitizer, 30 MS/s

• N8241A arbitrary waveform generator, 15-Bit, 1.25 GS/s or 625 MS/s

• N8242A arbitrary waveform generator, 10-Bit, 1.25 GS/s or 625 MS/s

For further information, refer to:

http://www.agilent.com/find/synthetic
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User’s Guide
1
Software Installation

This installation process installs the required software and instrument drivers used by the 
N8201A performance downconverter:

“Verify the PC Meets Minimum Requirements" on page 10

“Step 1. Install the Agilent I/O Libraries" on page 11

“Step 2. Install the IVI Shared Components" on page 13

“Step 3. Install the IVI-COM Drivers" on page 14

“Step 4. Install the Agilent Synthetic Instrument GUI" on page 15

“Step 5. Install the Agilent Synthetic Instrument Finder" on page 16

“Step 6. Install the N8201A Performance Downconverter 
User Interface" on page 17

Install the following only if the N8201A performance downconverter has Option H02

“(Optional) Step 7. Install the Agilent N8201A Option H02 
Spectrum Analyzer GUI" on page 19

Install the following only if the N8201A performance downconverter has Option H02
(Steps 8, 9, and 10 are available to support legacy installations.)

“(Optional) Step 8. Install the Microsoft Virtual Machine (VM)" on page 20

“(Optional) Step 9. Install the Apache HTTP Server" on page 21

“(Optional) Step 10. Install the SA Remote Web Server" on page 23
9Agilent Technologies



1 Software Installation
Installing Software and Instrument Drivers

Verify the PC Meets Minimum Requirements
10
• 1 GHz Intel Pentium processor 

• Microsoft Windows XP Professional or Home Edition (Service Pack 1 or 2), 
Windows 2000 (Service Pack 2) 

• 512 MB of RAM 

• Up to 40 MB of available hard-disk space 

• Microsoft Internet Explorer 6.0 (or higher), or Netscape 7.1 or 8.0

The following software and instrument drivers are required to operate the 
N8201A performance downconverter. 
CAUTION If the following software or instrument drivers are installed on the PC to be used, uninstall 
them and install the software and instrument drivers shipped on the 
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 
3 Hz to 26.5 GHz, Instrument Drivers and Documentation CD (N8201-90004):

1. Agilent I/O Libraries 
2. IVI Shared Components 
3. IVI-COM Drivers 
4. Agilent Synthetic Instrument GUI 
5. Agilent Synthetic Instrument Finder 
6. Agilent N8201A Performance Downconverter User Interface

Install the following only if the downconverter has Option H02

(Optional)   7. Agilent N8201A Option H02 Spectrum Analyzer GUI  
(Optional)   8. Microsoft Virtual Machine (VM) 
(Optional)   9. Apache HTTP Server 
(Optional) 10. SA Remote Web Server
1 Place the Agilent N8201A Performance Downconverter Synthetic Instrument Module, 
3 Hz to 26.5 GHz, Instrument Drivers and Documentation CD in the CD-ROM drive. 
NOTE Adobe Acrobat Reader is used during this installation process.

a If your computer does not have Adobe Acrobat Reader 5.0 or later, install it from the 
Instrument Drivers and Documentation CD (N8201-90004) described above.

b Click Adobe Acrobat Reader 5.0 to install the software.
2 Click Instrument Drivers.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
Step 1. Install the Agilent I/O Libraries
Agilent N8201A Perfo
1 Select Agilent I/O Libraries. 

2 Click the check box, “Do not show this message again” so that the check box is 
selected. This will stop the message from displaying each time a selection is made from 
the Software and Driver Installation menu.

3 Click Open.

4 Follow the instructions and accept the default settings.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 11
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1 Software Installation
5 Uncheck the check box stating, “Yes, I want to connect to my instrument. Launch 
Agilent Connection Expert”. The instrument will be connected later in the process after 
all of the required software has been installed. 

6 Click Finish.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
Step 2. Install the IVI Shared Components
Agilent N8201A Perfo
1 Select IVI Shared Components.

2 Follow the installation instructions and accept the default settings.

3 Click Finish.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 13



1 Software Installation
Step 3. Install the IVI-COM Drivers
14
1 Select IVI-COM Drivers.

2 Follow the installation instructions and accept the default settings.

3 Click Finish.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
Step 4. Install the Agilent Synthetic Instrument GUI
Agilent N8201A Perfo
1 Select Agilent Synthetic Instrument GUI.

2 Follow the installation instructions and accept the default settings.

3 Click Close.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 15



1 Software Installation
Step 5. Install the Agilent Synthetic Instrument Finder
16
1 Select Agilent Synthetic Instrument Finder.

2 Follow the installation instructions and accept the default settings.

3 Click Close.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
Step 6. Install the N8201A Performance Downconverter User Interface
Agilent N8201A Perfo
1 Select Agilent N8201A Performance Downconverter User Interface.

2 Follow the installation instructions and accept the default settings.

3 Click Close.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 17



1 Software Installation
Installing Optional Software and Instrument Drivers
18
Software for steps 7, 8, 9, and 10 can be installed on your PC, but Option H02 is required to 
use these software applications with the N8201A performance downconverter; prior to 
continuing, verify that Option H02 is installed.

To Verify that Option H02 is Installed

1 Start the Synthetic Instrument Finder (from the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder).

2 Select an instrument, from the left-hand pane of the Synthetic Instrument Finder, and 
right-click on the instrument with the mouse.

3 Select Interactive IO.

4 Type *OPT? at the Command prompt and click Send & Read.

5 Read the response in the Instrument Session History box; the required option should be 
listed as H02.

If Option H02 is Installed

• If Option H02 is installed, proceed to “(Optional) Step 7. Install the Agilent N8201A 
Option H02 Spectrum Analyzer GUI" on page 19.

• If Option H02 is installed, you can also use the SA Remote Web Server. To use this 
optional interface, you must perform “(Optional) Step 8. Install the Microsoft Virtual 
Machine (VM)" on page 20, “(Optional) Step 9. Install the Apache HTTP Server" on 
page 21, and “(Optional) Step 10. Install the SA Remote Web Server" on page 23; this 
interface can be installed along with the Agilent N8201A Option H02 Spectrum Analyzer 
GUI, but only one interface can be used at any given time. 

If Option H02 is Not Installed

• If Option H02 is not installed, software installation is complete! 
 
The N8201A performance downconverter can be manually controlled on instruments 
without Option H02 by using the Agilent Synthetic Instrument GUI. 
(Refer to “Starting the Agilent Synthetic Instrument GUI" on page 64.)

• Without Option H02, the Agilent N8201A Option H02 Spectrum Analyzer GUI cannot 
be used and does not need the software installed.

• Without Option H02, the N8201A performance downconverter cannot be used with 
the SA Remote Web Server and does not need software installed for the Microsoft  
Virtual Machine (VM), the Apache HTTP Server, or the SA Remote Web Server.

a Close the Interactive IO dialog box.

b Close the Synthetic Instrument Finder dialog box.

c Click Exit CD-ROM. The software and driver installation is complete!

d Restart the computer and continue to “Hardware Setup and Configuration" on 
page 25.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
(Optional) Step 7. Install the Agilent N8201A Option H02 Spectrum Analyzer GUI
Agilent N8201A Perfo
NOTE Before performing this optional installation step, read about 
“Installing Optional Software and Instrument Drivers" on page 18.
1 Select Agilent N8201A Option H02 Spectrum Analyzer GUI.

2 Follow the installation instructions and accept the default settings.

3 Click Close.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 19



1 Software Installation
(Optional) Step 8. Install the Microsoft Virtual Machine (VM)
20
NOTE Before performing this optional installation step, read about 
“Installing Optional Software and Instrument Drivers" on page 18.
1 Select Microsoft Virtual Machine (VM).

2 Follow the installation instructions and accept the default settings.

3 Click OK.

4 Click No on the Microsoft VM dialog box. This step will be completed later in the 
process after the SA Remote Web Server is installed.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
(Optional) Step 9. Install the Apache HTTP Server
Agilent N8201A Perfo
NOTE Before performing this optional installation step, read about 
“Installing Optional Software and Instrument Drivers" on page 18.
1 Select Apache HTTP Server.

2 Follow the installation instructions and accept the default settings

3 Click Next.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 21
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1 Software Installation
4 Click Next.

5 Click Finish.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Software Installation 1
(Optional) Step 10. Install the SA Remote Web Server
Agilent N8201A Perfo
NOTE Before performing this optional installation step, read about 
“Installing Optional Software and Instrument Drivers" on page 18.
1 Select SA Remote Web Server.

2 Follow the installation instructions and accept the default settings.

3 Click Finish.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 23
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1 Software Installation
4 Click Cancel on the Configure dialog box. This step will be completed later in the 
process after restarting the computer.

5 Close the Agilent N8201A Performance Downconverter Software and Driver Installation 
menu (driver_installation_list.pdf dialog box).

6 Click Exit CD-ROM. The software and driver installation is complete.

7 Restart the computer and continue to “Hardware Setup and Configuration" on page 25.
NOTE Restart the computer!
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



User’s Guide
2
Hardware Setup and Configuration

“Step 1. Unpack the N8201A Performance Downconverter" on page 26

“Step 2. Connect LAN Cables and Turn On Power" on page 27

“Step 3. Verify Connection with Synthetic Instrument Finder" on page 30

“(Optional) Step 4. Connect to the Agilent N8201A Option H02 
Spectrum Analyzer GUI" on page 32

“(Optional) Step 5. Connect to an SA Remote Web Server" on page 34

“(Optional) Step 6. Verify Operation < 3 GHz" on page 41

“(Optional) Step 7. Verify Operation > 3 GHz" on page 45

“Troubleshooting" on page 48

• “Alternative Ways to Verify Connectivity to the PC" on page 48

• “How to Reset the LAN Configuration" on page 53

• “How to Set a Static IP Address" on page 54

• “How to Troubleshoot Connectivity Problems on the Network" on page 58

• “How to Determine a PCs Configuration Settings" on page 58

• “If the Instrument was Unable to Join the LAN" on page 60

• “If the LAN LED is Red" on page 60”

• “If the Instrument’s IP Address or Hostname Cannot be Found with Ping" on page 61

• “If the Instrument is Not Found by the Synthetic Instrument Finder" on page 61”

• “If the Instrument’s Hostname and PC Cannot Communicate" on page 61”

• “If the Instrument Web Page is Not Visible" on page 62”

• “If the Software Driver Will Not Open the Connection" on page 62”
25Agilent Technologies



2 Hardware Setup and Configuration
Step 1. Unpack the N8201A Performance Downconverter

WARNING The unique shape of the N8201A performance downconverter was intended to allow 
multiple instruments to reside in a compact system that is both modular and 
transportable. With instruments adjacent to each other, handles could not be installed on 
the respective instruments. Exercise caution when lifting and carrying the instrument to 
avoid personal injury. At 25.9 kilograms (57 pounds) shipping weight and 19 kilograms 
(42 pounds) net weight, it is recommended that two people be utilized for instrument 
lifting and transport. 
26
NOTE Verify that any options ordered are included with the shipment by checking the packing 
literature included with the shipment.

The serial number label on the N8201A performance downconverter only verifies 
hardware/firmware options. The packing literature verifies all items shipped.
Verify the Shipment
1 Inspect the shipping container for damage. 
 
Signs of damage may include a dented or torn shipping container or cushioning material 
that shows signs of unusual stress or compacting. 

2 Carefully remove the contents from the shipping container and verify that the order is 
complete. 

The following items are shipped standard with each N8201A performance 
downconverter:

• instrument drivers, synthetic graphical user interface, and documentation CD-ROM 
(p/n N8201-90004)

• three-prong AC power cord specific to geographic location 
(Optional) Prepare the Instrument for Rack Mounting

CAUTION If the N8201A performance downconverter is to be placed in a system rack, the feet 
currently attached can be replaced with the rack mount feet (part number 
W1312-40032) supplied with the accessories. Failure to do so can result in a safety 
issue.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Hardware Setup and Configuration 2
Step 2. Connect LAN Cables and Turn On Power
Agilent N8201A Perfo
Before connecting to a LAN, verify your local policy by contacting the system administrator 
in your Information Technology (IT) department and inquire about connecting instruments 
to the LAN. 

• If the network uses DHCP [Dynamic Host Configuration Protocol], an address is 
assigned to the device automatically. If you need to know what the IP address is, it can 
be determined using the Synthetic Instrument Finder. (Refer to “Step 3. Verify 
Connection with Synthetic Instrument Finder" on page 30.)

• If DHCP is not present, but the instrument is set to use DHCP (the default), the 
instrument waits two minutes for its DHCP request to time out. When the 
N8201A performance downconverter is used in this situation, there is a time delay of 
approximately three minutes between the time of when the N8201A performance 
downconverter’s power is turned on and when it is available for use.

• If the network does not use DHCP, you can use Auto IP or configure your LAN 
settings manually. Although you can also manually configure LAN settings in a 
network with DHCP, it is recommended that you do so with the assistance of your 
system administrator. 

• If the network uses Auto IP (does not use DHCP), the N8201A performance 
downconverter acquires a 169.254.xxx.xxx address. (Refer to “How to Set a Static IP 
Address" on page 54.) 
NOTE If you wish to communicate directly between the N8201A performance downconverter and 
your PC without the use of a LAN hub, you can connect directly to your PC. (Refer to 
“(Optional) Connect to a LAN with a Cross-Over LAN Cable" on page 29.)
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 27
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2 Hardware Setup and Configuration
1 Connect a LAN cable from the LAN connector on your PC to an empty connector on your 
internal local area network or LAN hub.

2 Connect a LAN cable from the LAN connector on the rear panel of the 
N8201A performance downconverter to an empty connector on your internal local area 
network or LAN hub.

3 Turn on power to the PC.

4 Turn on power to the N8201A performance downconverter and wait until the LAN LED 
turns solid green or until you hear an attenuator click from within the 
N8201A performance downconverter; this can take up to four minutes depending on 
whether the instrument is using DHCP or Auto IP.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Hardware Setup and Configuration 2
(Optional) Connect to a LAN with a Cross-Over LAN Cable
Agilent N8201A Perfo
If you wish to communicate directly between the N8201A performance downconverter and 
your PC without the use of a LAN hub, you can connect directly to your PC.

1 Connect a cross-over LAN cable from the LAN connector on your PC to the LAN 
connector on the rear panel of the N8201A performance downconverter.

2 Turn on power to the PC.

3 Turn on power to the N8201A performance downconverter and wait until the LAN LED 
turns solid green or until you hear an attenuator click from within the 
N8201A performance downconverter; this can take up to four minutes depending on 
whether the instrument is using DHCP or Auto IP.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 29



2 Hardware Setup and Configuration
Step 3. Verify Connection with Synthetic Instrument Finder
30
Agilent supplies a program named the Synthetic Instrument Finder that enables 
connection between a PC and instruments that are connected on a LAN [Local Area 
Network].

1 From the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder. 
 
The Synthetic Instrument Finder should appear and look similar to the following.

2 Select an instrument, from the left-hand pane of the Synthetic Instrument Finder, and 
right-click on an instrument with the mouse. 
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Hardware Setup and Configuration 2

Agilent N8201A Perfo
3 Select Open Webpage and a Web browser should appear that allows viewing and 
modifying settings for instruments on the network. 
• If this Web page does not open or you experience an error, refer to 
“Troubleshooting" on page 48. 

• If this Web page opens, you have verified connectivity and can continue 
on to one of the following:

• With Option H02 not installed, refer to 
“Using the Agilent Synthetic Instrument GUI" on page 63

• With Option H02 installed, refer to 
“(Optional) Step 4. Connect to the Agilent N8201A Option H02 Spectrum Analyzer 
GUI" on page 32

• With Option H02 installed, refer to 
“(Optional) Step 5. Connect to an SA Remote Web Server" on page 34.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 31



2 Hardware Setup and Configuration
(Optional) Step 4. Connect to the Agilent N8201A Option H02 
Spectrum Analyzer GUI
32
NOTE If Option H02 is not installed, the Agilent N8201A Option H02 Spectrum Analyzer GUI 
software cannot be used!

In addition to Option H02, you must have performed “(Optional) Step 7. Install the Agilent 
N8201A Option H02 Spectrum Analyzer GUI" on page 19; this interface can be installed 
along with the SA Web Remote Server, but only one interface can be used at any given time. 
(For further software installation information, refer to “Installing Optional Software and 
Instrument Drivers" on page 18.) 
 
The N8201A performance downconverter can be manually controlled on instruments 
without Option H02 by using the Agilent Synthetic Instrument GUI. 
(Refer to “Starting the Agilent Synthetic Instrument GUI" on page 64.)
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Hardware Setup and Configuration 2

Agilent N8201A Perfo
This section describes how to access and use the Agilent N8201A Option H02 
Spectrum Analyzer GUI.

1 From the Windows Desktop, click 
Start > All Programs > Agilent SI Tools > N8201A Option H02 Spectrum Analyzer GUI.

2 Click File > Connect (upper-left corner) 
on the Agilent N8201A Option H02 Spectrum Analyzer GUI. 
3 Enter the VISA Address (for example, TCPIP0::141.121.87.18::inst0::instr) of the 
instrument being connected to and click OK.

• If you don’t know the IP address of the instrument, that is used as part of the 
VISA Address connection string, refer to the Default IP Address that is displayed 
when verifying connection with the Synthetic Instrument Finder. (Refer to “Step 3. 
Verify Connection with Synthetic Instrument Finder" on page 30.)

The Agilent N8201A Option H02 Spectrum Analyzer GUI controls the N8201A performance 
downconverter that is equipped with Option H02 and simulates the functionality of an 
Agilent PSA spectrum analyzer. To learn how to use the controls of this GUI interface, refer 
to the PSA documentation.

PSA documentation is available from the Agilent N8201A Performance Downconverter 
Synthetic Instrument Module, 3 Hz to 26.5 GHz, Instrument Drivers and Documentation CD 
(refer to “Installing Software and Instrument Drivers" on page 10) or from the Web at:

http://www.agilent.com/find/psa
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(Optional) Step 5. Connect to an SA Remote Web Server

NOTE If Option H02 is not installed, the SA Remote Web Server software cannot be used!

In addition to Option H02, you must have installed the Microsoft Virtual Machine (VM), the 
Apache HTTP Server, and the SA Remote Web Server software; this interface can be 
installed along with the Agilent N8201A Option H02 Spectrum Analyzer GUI, but only one 
interface can be used at any given time. (For further software installation information, refer 
to “Installing Optional Software and Instrument Drivers" on page 18.) 
 
The N8201A performance downconverter can be manually controlled on instruments 
without Option H02 by using the Agilent Synthetic Instrument GUI. 
(Refer to “Starting the Agilent Synthetic Instrument GUI" on page 64.)
34
1 From the Windows Desktop, 
select Start > All Programs > Agilent I/O Libraries Suite > Agilent Connection Expert.

2 Click Add Interface. 
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3 Select Remote GPIB (via E5810 or Remote IO Server).

4 Click Add.

5 Enter the N8201A performance downconverter’s IP address. 
 
If you do not know the IP address, use the Synthetic Instrument Finder.

a From the Windows Desktop, 
select Start > All Programs > Agilent SI Tools> Synthetic Instrument Finder.

b Select an instrument from the list of instruments shown to see its IP address. 

IP Address
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The Remote GPIB interface dialog box should look similar to the following: 

6 Select IP address and enter the IP Address of the N8201A performance downconverter 
in the Remote GPIB Interface dialog box.

7 Enter gpib7 for the Interface Name on Remote Host.

8 Click Test connection. If the connection was successful, text stating “The interface was 
successfully opened“ should appear.

9 Click OK.
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10 From the Windows Desktop, 
select Start > All Programs > Agilent Web Remote > SA > Configure and a 
Configure dialog box similar to the following should appear.

11 Click Continue and a dialog box similar to the following should appear.

12 Click Yes on the Instrument Information dialog box.

13 Click OK.

14 From the Windows Desktop, select Start > Run.

15 Enter CMD in the Run dialog box to select the Command Window.
rmance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz 37



38

2 Hardware Setup and Configuration
16 From the command window prompt, type ipconfig to get the IP Address of your 
computer. 

17 Write down your computer's IP address. 
 
IP Address: __ __ __ . __ __ __ . __ __ __ . __ __ __  
 
This IP address is needed in the following steps. 
 
If you are attempting to access the web server from another machine, you need to make 
sure to use the hostname or IP Address of the adapter that is on the same network as 
the machine you are using. (In regards to the example above, if you are trying to access 
the webpage from a machine on the network that is connected to the adapter with the 
169.254.241.150 address, you need to use 169.254.241.150 and not 141.121.83.141 as the 
IP Address.) 
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18 From the Windows Desktop, 
select Start > All Programs > Agilent Web Remote > SA > Start Server to start the 
Spectrum Analyzer Instrument Server.

19 From the Windows Desktop, select Microsoft’s Internet Explorer.

20 Insert your PC’s IP address (from the command window above). 
 
Use the following syntax: http://141.121.83.141/index.html and a 
display similar to the following should appear. 
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21 Select Web Control SA on the left of the web page.

• If one of the following dialog boxes appears, click Run or Install and accept the 
installation.

If the following display appears, the SA Remote Web Server configuration is complete!
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(Optional) Step 6. Verify Operation < 3 GHz
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Operation verification is a test that, when completed, will ensure that the downconverter is 
operating correctly in the low band (< 3 GHz).
Performing a Self-Test

CAUTION Make sure that the total power of all signals at the downconverter input does not 
exceed +30 dBm (1 watt).
Instrument Connections

• Downconverter: 7.5 MHz Out

• Spectrum Analyzer: RF Input

The N8201A performance downconverter can be controlled with either the 
NOTE
SA Remote Web Server or the Agilent Synthetic Instrument GUI, but only one interface can 
be used at any given time. 

• If Option H02 is not installed, the N8201A performance downconverter can be manually 
controlled using the Agilent Synthetic Instrument GUI.

• If Option H02 is installed, you can use either the SA Remote Web Server or the 
Agilent Synthetic Instrument GUI. 
 
(For information on using these different interfaces, refer to “(Optional) Step 4. Connect 
to the Agilent N8201A Option H02 Spectrum Analyzer GUI" on page 32 or “Starting the 
Agilent Synthetic Instrument GUI" on page 64.)
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Perform the following procedure to run a self-test:

1 Close SA Remote Web Server.

2 From the Windows Desktop, 
select Start > All Programs > Agilent SI Tools > Agilent Synthetic Instrument GUI.

3 Click the listed downconverter in the “Agilent Synthetic Instrument GUI, 
Recent Connections” dialog box.
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4 The following dialog box should appear.
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Measurement Procedure

5 Tune the Spectrum Analyzer to the following:

• Frequency: 7.5 MHz

• Amplitude: 10 dBm

• Span: 100 kHz

6 Tune the downconverter to the following:

• Level: Attenuator: 20 dBm

• RF Enabled: Enabled

• Input RF: Signal Source: 50 MHz Cal

• Frequency: 50 MHz

7 Verify that a 7.5 MHz signal is present on the spectrum analyzer.
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(Optional) Step 7. Verify Operation > 3 GHz
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Operation verification is a test that, when completed, will ensure that the 
N8201A performance downconverter is operating correctly in the high band (> 3 GHz).
Performing a Self-Test

CAUTION Make sure that the total power of all signals at the N8201A performance 
downconverter input does not exceed +30 dBm (1 watt).
Downconverter to Spectrum Analyzer Connections

• Downconverter: 7.5 MHz Out

• Spectrum Analyzer: RF Input

Downconverter to Source Connections

• Downconverter: RF Input

• Source: RF Output

Perform the following procedure to run a self-test:

1 From the Windows Desktop, 
select Start > All Programs > Agilent SI Tools > Agilent Synthetic Instrument GUI.
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2 Click the downconverter in the Agilent Synthetic Instrument GUI dialog box listed under 
Recent Connections.

3 The following dialog box should appear.
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Measurement Procedure

4 Tune the Spectrum Analyzer to the following:

• Frequency: 7.5 MHz

• Amplitude: 10 dBm

• Span: 100 kHz

5 Tune the downconverter to the following:

• Center Frequency: 3.5 GHz

• Attenuator: 20 dBm

• RF Enabled: Enabled

• Source: Internal

6 Tune the Source to the following:

• Frequency: 3.5 GHz

• Amplitude: 0 dBm

• RF On

Verify that a 7.5 MHz signal is present on the spectrum analyzer.
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Troubleshooting

Alternative Ways to Verify Connectivity to the PC
48
In addition to using “Step 3. Verify Connection with Synthetic Instrument Finder" on 
page 30 and “(Optional) Step 4. Connect to the Agilent N8201A Option H02 
Spectrum Analyzer GUI" on page 32, connectivity can be verified between the 
N8201A performance downconverter and the PC with the following:

• Verify that the LAN LED on the N8201A performance downconverter’s rear panel is 
green or blinking green. This indicates a good connection. 
 
If the LED is off, there is a problem with your LAN connection. 

• Verify that the LAN LED on the N8201A performance downconverter’s front panel (next 
to the LAN port) is solid green. 
 
If the LED turns red, this indicates a problem with your LAN connection. This takes 
approximately 60 seconds. 

• Ping the N8201A performance downconverter from the PC.

a From the Windows Desktop, select Start > Run.

b At the Open prompt, type CMD and press Enter to open a command window.

c At the command prompt, type Ping and the instrument’s IP address (for example, 
Ping 141.121.84.108.) or type Ping and the instruments hostname (for 
example, Ping a-n8201a-00179).
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How to Use the Synthetic Instrument Finder
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Agilent supplies a program named the Synthetic Instrument Finder that enables 
connection between a PC and instruments that are connected on a LAN [Local Area 
Network].

1 From the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder. 
 
The Synthetic Instrument Finder should appear and look similar to the following.

2 Select an instrument, from left-hand pane of the Synthetic Instrument Finder, and 
right-click on an instrument with the mouse. 
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The Synthetic Instrument Finder window is divided into two main sections:

• right pane contains information specific to the instrument highlighted in the left pane.

• left pane contains a list of equipment available on your LAN for connection.

Right-Pane Functions

Send Settings  Sends the current instrument settings to the N8201A performance 
downconverter. Use this function if you modified the settings in Instrument Finder.

5 Second Identify Flashes the LAN LED for five seconds. 

Turn On Ident LED  When On, the LAN LED continuously flashes on and off. Once the 
Turn On Ident LED button is pressed, the button name changes to Turn Off Ident LED.

Refresh List Updates the device’s list.

Continuous Refresh Updates the device’s list every one minute.

Add Device Manually Allows you to add a device for connection. Use this feature 
only if your instrument does not appear in the Devices list.

a Click Add Device Manually. The Devices area will display a new listing titled 
“Unknown”.

b In the Manual settings area, enter in the MAC address, serial number, and model 
number of the device.

c In the LAN settings area, enter in the information for the new device. (Make sure 
that you scroll down the list to get to the editable settings area.)

d Click Send Settings to enter this information in the Devices area.

e Double-click the new listing to open the webpage, or right-click and select Open 
using Synthetic GUI to use the virtual interface.
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Left-Pane Functions

In the left pane, right-click on the N8201A performance downconverter and the 
following menu should appear. 

Interactive IO Opens the Agilent Interactive IO application which allows SCPI 
commands to be sent to the instrument. (The Interactive IO option is only available if the 
Agilent Connection Expert has been installed on the PC.)
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Open Webpage Opens the Web page associated with the currently selected instrument. 
From this Web page, settings for the instrument can be viewed and modified.

Tip:  There are two other ways to access the device’s Web page:

• By double-clicking on the Device listing in the Synthetic Instrument Finder.

• By typing in the device’s hostname or IP address in your Internet browser.
Open using Synthetic GUI Opens the Synthetic Instrument GUI.

Copy VISA Address to Clipboard (IP Address) Copies the VISA IP address to the 
clipboard for use in other applications.

Copy VISA Address to Clipboard (Hostname) Copies the VISA hostname to the 
clipboard for use in other applications. It is recommended that you use this address on 
networks with DHCP and DNS network capability.
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How to Reset the LAN Configuration
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On the instrument front panel, near the power switch, is a recessed button labeled 
“RESET”. This button enables you to place the LAN configuration of the instrument 
into a known state. 

When this button is pressed (a straightened paper clip will do the job) the following 
settings are made and the system reboots.

• Subnet Mask is set to 255.255.0.0

• DHCP is set to on

• Auto IP is set to on

• If DHCP and Auto IP are set to off, the IP address will be set to 192.168.EE.FF, 
where EE and FF are the last two parts of the MAC address (AA.BB.CC.DD.EE.FF). 
This is designed to prevent multiple instruments from using the same default IP 
address (refer to the instrument label).
NOTE If you had manually configured LAN settings before, you may have to reconfigure your 
instrument to reset DHCP and Auto IP to OFF. Refer to “How to Set a Static IP Address" on 
page 54.
• The instrument hostname is set to A-N82XXA-NNNNN, where N82XXA is the 
instrument model number (such as N8201A) and NNNNN represents the last five 
digits of the instrument serial number.

If the instrument is in an environment with a DHCP server, it is assigned an IP address 
through DHCP. The IP address can be found by using the instrument hostname as the 
URL in a web browser.

Without DHCP, the instrument will use Auto IP and acquire a 169.254.X.X address. If 
no DHCP is present, but the instrument is set to use DHCP (the default), the instrument 
will wait two minutes for its DHCP request to time out. In this case, there is a time delay 
of approximately three minutes between when the instrument is powered on and when it 
is usable.

Recessed
LAN RST
Button
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How to Set a Static IP Address
54
The DHCP server automates the process of setting up the IP addresses on your network 
by default. When the N8201A performance downconverter is turned on, it searches for a 
DHCP server on the network and selects a “dynamic IP address”. Each time the 
N8201A performance downconverter is rebooted, the N8201A performance 
downconverter may get a different IP address. To set the N8201A performance 
downconverter to a static IP address, rather than allowing the DHCP server to select an 
auto IP address:

1 Assign a N8201A performance downconverter instrument IP address that will work with 
your computer.
F

NOTE For a company wide network, your system administrator will have to assign an IP address 
that is compatible with your PC. If you have a private LAN network or a direct connection 
from your PC to the instrument, you can assign the IP address. Refer to “Step 1. Unpack the 
N8201A Performance Downconverter" on page 26.
2 Connect the N8201A performance downconverter in one of the following two 
configurations:

• Connect a LAN cable from the LAN connector on your PC to an empty connector on 
your internal local area network or LAN hub. Connect a LAN cable from the LAN 
connector on the rear panel of the N8201A performance downconverter to an empty 
connector on your internal local area network or LAN hub. 
Figure 1 Connecting the PC LAN cable to a company/private LAN to the instrument LAN

• Connect a cross-over cable from the LAN connector on your PC to the LAN 
connector on the rear panel of the N8201A performance downconverter.
Agilent N8201A Performance Downconverter Synthetic Instrument Module, 3 Hz to 26.5 GHz



Hardware Setup and Configuration 2

Agilent N8201A Perfo
Figure 2 Connecting the PC LAN cable to the instrument LAN (cross-over cable)

3 Turn on power to the PC.

4 Turn on power to the N8201A performance downconverter and wait until the LAN LED 
turns solid green; this takes about 60 seconds.

5 From the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder.

The following Synthetic Instrument Finder dialog box should appear.

6 Select the N8201A performance downconverter listed in the Agilent Synthetic 
Instrument Finder dialog box to access the N8201A performance downconverter Web 
page.
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7 Click View & Modify LAN Config in the left-pane of the Web page. The following dialog 
box should appear.
8 Click Modify Configuration to access the Password dialog.

9 Click Submit (accept the default password) and the following dialog box should appear. 
The default password is set to “agilent”. 

Tip: You can change the password from the View & Modify LAN Connections. (Scroll 
down the Parameter column until you locate the Change Password parameter.)
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10 Change the DHCP and Auto IP radio-buttons to Off. Change the IP address, Subnet 
Mask, and Default Gateway values to meet your network requirements.

11 Click Save to save the new settings. Parameters marked with an asterisk (*) also require 
that you click "Renew LAN settings" before changes take effect.
NOTE For the new settings to become effective, you may first cycle the power of the instrument 
and then cycle the power of the PC.
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How to Troubleshoot Connectivity Problems on the Network
58
The Synthetic Instrument Finder program is used to find instruments on a network when 
the N8201A performance downconverter is connected through a router or cross-over 
cable. There are three possible configurations: 

• connecting the PC through a company wide site LAN connection to the 
N8201A performance downconverter

• connecting the PC to the same private LAN network as the instrument

• connecting the PC directly to the instrument using a cross-over cable - this would 
typically be used for troubleshooting and is not normally used to control an 
instrument directly

The N8201A performance downconverter is shipped with a default IP address. This 
default IP address is 192.168.EE.FF, where EE and FF are the last two parts of the 
Media Access Control (MAC) address (AA.BB.CC.DD.EE.FF).
How to Determine a PCs Configuration Settings
From a DOS Window

1 From the Windows Desktop, click Start > Run.

2 At the Open: prompt, type CMD and press Enter to open a DOS window.

3 At the command prompt, type ipconfig/all to display the PCs network connection 
details.

Or,

From the PCs Control Panel

1 From the Windows Desktop, click Start > Settings > Control Panel > Network and 
Internet Connections.

2 From the Network and Internet Connections window, double-click the Local Area 
Connection.

3 In the Local Area Connection Status dialog, click the Support tab and click Details to 
display the PCs Network Connection Details.

The Network Connection Details include:

• Physical Address

• DHCP status, enabled or disabled (displayed when using the DOS window ipconfig 
command only)

• Auto configuration enabled or disabled (displayed when using the DOS window 
ipconfig command only)

• IP Address

• Subnet Mask
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• Default Gateway

• DHCP Server Address

• Lease Obtained

• Lease Expired

• Primary WINS Servers

• Secondary WINS Servers
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If the Instrument was Unable to Join the LAN
60
or
If the LAN LED is Red

Symptom

Possible Causes Possible Solutions

The instrument is not connected to a LAN. If connecting the instrument to a switch or hub, verify 
that the instrument is connected with a standard LAN 
cable.

An incorrect LAN cable is being used. • If connecting the instrument directly to a PC, verify 
that the instrument is connected with a cross-over 
cable.

• If connecting the instrument to a switch or hub, 
verify that the instrument is connected with a 
standard LAN cable.

The device’s LAN port is not active. Connect the instrument to a known working LAN 
port.

The device is configured to use DHCP, but no DHCP 
server is available.

• Disable DHCP. Refer to “How to Set a Static IP 
Address" on page 54.

• Connect the device to a LAN that uses a DHCP 
server.

The instrument is configured to use a duplicate static 
IP address.

• Make sure that no other device is using the same 
IP address as your instrument.

• Configure your instrument to use a different IP 
address. Refer to “How to Set a Static IP 
Address" on page 54.
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If the Instrument’s IP Address or Hostname Cannot be Found with Ping

If the Instrument is Not Found by the Synthetic Instrument Finder

If the Instrument’s Hostname and PC Cannot Communicate

Possible Causes Possible Solutions

The instrument was unable to join the LAN. See “If the Instrument was Unable to Join the 
LAN" on page 60.

The instrument’s LAN settings are incorrect. Verify that the instrument’s settings are appropriate 
for your LAN. 

A firewall is preventing communication between your 
PC and your instrument.

Make sure that your firewall settings allow 
communication between your PC and other devices.

The instrument is using Auto-IP (That is, the 
instrument assigned itself a 169.254.x.x IP address) 
and your PC is not using Auto IP (That is, PC does not 
have a 169.254.x.x IP address.)

• Disable Auto-IP on the instrument. 
• Configure your PC to use Auto-IP.

Possible Causes Possible Solutions

The instrument was unable to join the LAN. See “If the Instrument was Unable to Join the 
LAN" on page 60.

The instrument and PC are on different 
switches/hubs and different subnets.

• Put the instrument on the same switch or hub as 
your PC.

• If the instrument is using DHCP, make sure that the 
instrument and the PC are put on the same subnet.

• If the instrument is using a static IP address, make 
sure that the instrument IP address and subnet 
mask put the instrument on the same subnet as 
your PC.

Possible Causes Possible Solutions

No DNS server is available. Communicate with the instrument using the 
instrument’s IP address.

The DNS server has not been updated. Wait several minutes.

The PC cannot communicate with the device over 
LAN.

See “If the Instrument’s IP Address or Hostname 
Cannot be Found with Ping" on page 61.
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If the Instrument Web Page is Not Visible

If the Software Driver Will Not Open the Connection

Possible Causes Possible Solutions

• The instrument has not yet joined the LAN.
• The instrument is unable to join the LAN.

See “If the LAN LED is Red" on page 60.

Your PC cannot communicate with the device over 
your LAN.

See “If the Instrument was Unable to Join the 
LAN" on page 60.

You are attempting to use the device’s hostname and 
the hostname is not working.

See “If the Instrument’s Hostname and PC Cannot 
Communicate" on page 61.

Your browser is configured to use a proxy, and the 
proxy does not allow communication with 
instruments on the LAN. 

Disable or reconfigure the proxy settings. Open 
Internet Explorer and select Tools > Internet Options 
> Connections > LAN Settings… 

Possible Causes Possible Solutions

Your PC cannot communicate with the device over 
your LAN.

See “If the Instrument’s IP Address or Hostname 
Cannot be Found with Ping" on page 61.

Someone else is currently connected to the 
instrument.

Make sure that no one else is connected to the 
instrument.
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3
Using the 
Agilent Synthetic Instrument GUI

“Starting the Agilent Synthetic Instrument GUI" on page 64

“Features of the Agilent Synthetic Instrument GUI" on page 66

“Settings on the Agilent Synthetic Instrument GUI" on page 71
NOTE The N8201A performance downconverter can be controlled with either the 
SA Remote Web Server or the Agilent Synthetic Instrument GUI, but only one interface can 
be used at any given time. 

• If Option H02 is not installed, the N8201A performance downconverter can be manually 
controlled using the Agilent Synthetic Instrument GUI.

• If Option H02 is installed, you can use either the Agilent N8201A Option H02 Spectrum 
Analyzer GUI, the SA Remote Web Server, or the Agilent Synthetic Instrument GUI. 
 
(For information on using these different interfaces, refer to “(Optional) Step 4. Connect 
to the Agilent N8201A Option H02 Spectrum Analyzer GUI" on page 32, “(Optional) Step 
5. Connect to an SA Remote Web Server" on page 34, or “Starting the Agilent Synthetic 
Instrument GUI" on page 64.)

To verify that Option H02 is installed:

1 Start the Synthetic Instrument Finder (from the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder).

2 Select an instrument, from the left-hand pane of the Synthetic Instrument Finder, and 
right-click on the instrument with the mouse.

3 Select Interactive IO.

4 Type *OPT? at the Command prompt and click Send & Read.

5 Read the response in the Instrument Session History box; the required option should be 
listed as H02.
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Starting the Agilent Synthetic Instrument GUI
64
This section describes how to access and use the Agilent Synthetic Instrument GUI.

1 From the Windows Desktop, 
click Start > All Programs > Agilent SI Tools > Agilent Synthetic Instrument GUI.

2 Click Connection Manager (lower-left corner) 
on the Agilent Synthetic Instrument GUI dialog box. 

3 Click Find Instruments (lower-left corner) on the Connect to Instrument dialog box. 
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4 Select an N8201A performance downconverter and click Test (lower-left corner) on the 
Connect to Instrument dialog box.

• If the bottom of the dialog box displays the message “Connection Succeeded“, the 
instrument was found and communication has been established.

• If the bottom of the dialog box displays the message “N8201A is not supported”, the 
instrument is not communicating. Refer to “Troubleshooting" on page 48.

5 Click Connect (lower-right corner) on the Connect to Instrument dialog box and the 
following dialog box should appear. 

If the Agilent Synthetic Instrument GUI appears, the N8201A performance downconverter 
has successfully connected using a LAN connection! 
Left Pane
The lower portion of the left pane displays the settings available for adjustment on the 
N8201A performance downconverter. Click a function button to activate that function and 
the related functions are displayed in the Properties area. For example, Center Frequency is 
the active function and all settings associated with Center Frequency are available for 
modification.
Right Pane
The upper portion of the right pane always displays the functions that are most commonly 
used for a measurement. These functions are also accessible from the left pane. Changing 
one of these parameters changes the setting in the left pane as well.

The lower portion of the right pane can have three tabs: Dynamic Help, Instrument 
Information, and the Event Log. For more information on theses areas, refer to “Dynamic 
Help" on page 69, “Instrument Information" on page 70, and “Event Log" on page 70.
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Features of the Agilent Synthetic Instrument GUI

File Menu
66
The File menu accesses options for instrument connection, save and recall settings, and 
exiting the application. Theses tasks are also available by clicking the icons on the tool bar.

Figure 3 File sub menu 

Connect 

Accesses the Connect to Instrument dialog box which is used to connect to an instrument 
on the LAN hub.

Figure 4 Connect to Instrument Window

Reconnect 

Re-establishes the connection to the instrument if the instrument has been disconnected.
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Disconnect

Terminates the connection to the active instrument that is using the 
Synthetic Instrument GUI.

Load Settings

Accesses the Load Instrument Properties dialog box where you can recall user-definable 
instrument settings.

Save Settings

Accesses the Save Instrument Properties dialog box where you can save instrument 
settings for use at a later time.

Exit 

Closes the Agilent Synthetic Instrument GUI application.
Help
The Help menu displays the current versions of the GUI and drivers.

Figure 5 Help About Synthetic GUI
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Start Page

The Start Page lists the instruments previously connected to the Agilent Synthetic 
Instrument GUI. 

Error Log

Displays a history of all instrument and GUI related errors and messages.

Figure 6 Error Log

Connection Manager Accesses the Connect to Instrument dialog box.

Table 1 Controls available from the Connect to Instrument Dialog Box

Saved Connections Accesses user defined connections.

Recent Connections Displays a list of instruments that have recently been controlled by the 
Agilent Synthetic Instrument GUI.

Connection Expert Accesses Agilent Connections Expert.

Find Instruments Lists the instruments found in Instrument Finder.

Test Tests the connection between the PC and the highlighted instrument.
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The upper portion of the right pane always displays the functions that are most commonly 
used for a measurement. These functions are also accessible from the left pane. Changing 
one of these parameters changes the setting in the left pane as well.

The lower portion of the right pane can have the following tabs: Dynamic Help, Instrument 
Information, and Event Log.

Dynamic Help

Provides information about the function currently selected in the left pane.

Figure 7 Dynamic Help 
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Instrument Information

Provides information about your N8201A performance downconverter such as the serial 
number, IP address, software revision used, and so on.
Figure 8 Instrument Information Page

Event Log

When enabled in the Events parameters area, displays the event log history.

Figure 9 Event Log History
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Settings on the Agilent Synthetic Instrument GUI

Frequency 
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Sets the center frequency or frequency offset of the N8201A performance downconverter.

Center Frequency

Sets the center frequency while the span remains constant. The frequency range of the 
N8201A performance downconverter is 3 Hz to 26.5 GHz plus the frequency offset. If the 
External Mixer Enabled equals External, the frequency range is 3 Hz to 335 GHz.

Frequency Offset 

Enables you to input a frequency offset value to account for external frequency 
conversions. This value is added to the display readout of the marker frequency, center 
frequency, start frequency, stop frequency, and all other absolute frequency settings. Limits 
are −500 THz to 500 THz.
Frequency List
Sets up a list of frequencies for the instrument to step through. The list begins with Start 
Frequency, and adds the Step Frequency until the Stop Frequency is reached. The next 
trigger causes the list to be repeated.

Disabled Prevents a frequency step sequence from being initiated.

Start Sets the first frequency that will be swept on a list sweep.

Stop Sets the last frequency that will be swept before the list is repeated.

Step Sets the difference between successive swept frequencies.

Trigger Setup Sets up the trigger that will be used to step through the frequency list.

Trigger Source

Sets the source of triggers. When the specified trigger occurs, the instrument will move to 
the next frequency in its frequency list. Possible values are:

EXT - TTL LX10 LX11 LX12 LX13

LX14 LX15 LX16 LX17 LAN0

LAN1 LAN2 LAN3 LAN4 LAN5

LAN6 LAN7 ALARM0
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Trigger Source (set to ALARM0)

Trigger Detection

Controls the trigger polarity. It is Positive to trigger on a rising edge and Negative to trigger 
on a falling edge.

Execute Trigger

Sends the new trigger settings to the instrument

Table 2 Controls available when Trigger Source is set to ALARM0

Alarm Mode Defines the way that Alarm Time will be interpreted. In absolute mode, 
the alarm will begin firing at the time of day specified in Absolute Alarm 
Time. In relative mode, the alarm will begin firing at a time relative to 
when the alarm is set up.

Relative Alarm Time Defines the number of seconds after pressing Execute Trigger that the 
first alarm will occur.

Absolute Alarm Time Defines the time that the first alarm will occur.

Alarm Period Defines the time between successive alarms.

Alarm Repeat Defines the number of times the alarm will be repeated.
A value of 1 means that the alarm will occur once and will not be 
repeated. A value of 2 means that the alarm will occur twice.
A value of 0 means that the alarm will be repeated until the alarm is 
disabled.
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Sets the input attenuation. The input attenuation can be set from 0 to 70 dB in 2 dB 
steps.The input impedance is set to 50 ohms. Input attenuation is used to minimize 
compression caused by a signal level that is too high in amplitude.
Input RF
Accesses the functions to select the input signal source (choices are RF, 50 MHz Cal, or 
External Mixer), enable a preamplifier, and to set the coupling to either AC or DC.
IF Output
Accesses the functions to set the IF Bandwidth and IF Frequency.
Reference Oscillator

Table 3 Grouped Values

IF Output IF Bandwidth 
Limits

IF Frequency 
Limits

Input Impedance 
Limits

IF Output 1 0 to 3 MHz 21.4 MHz 50 Ohm

IF Output 2 100 MHz 321.4 MHz 50 Ohm

IF Output 3 10 MHz 7.5 MHz 50 Ohm
Allows you to use either the internal or an external reference oscillator for making 
measurements.

Reference Output

Switches the 10 MHz out signal on the front panel of the N8201A performance 
downconverter On and Off.

Reference Input Source

Specifies whether to use an External or Internal source for the reference oscillator. If set to 
External, a value must be specified for External Frequency with limits from 1 MHz to 
30 MHz.
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Adjust

Allows you to manually adjust the preselector filter center frequency to optimize its 
response on the signal of interest. When enabled, the center frequency must be set to 
3.045 GHz or greater.

Limits are: –250 MHz to 250 MHz.

PreSelector Enabled

Enables or disables the preselector.

Enabled: Can be set if the Center Frequency is greater than 3.045000000 GHz.

Possible Values: Enabled, Disabled

Peak

Performs a peak search.

Enabled: Can run if Center Frequency is greater than 3.045000000 GHz.
Instrument Functions: A - L
External Mixer
Selects either the internal mixer or an external mm-wave mixer.

• When Internal mixing is selected, normal operation and all other external mixing 
functions are unavailable.

• When External mixing is selected, you can analyze high frequency signals (that is, 
higher than the spectrum analyzer’s maximum frequency) by using an appropriate 
external mixer.

Band Selects a band, or sets the frequency band to be user defined.

User Defined values:

• K - 18 to 26.5 GHz

• A - 26.5 to 40 GHz

• Q - 33 to 50 GHz

• U - 40 to 60 GHz

• V - 50 to 75 GHz

• E - 60 to 90 GHz

• W - 75 to 110 GHz

• F - 90 to 140 GHz

• D - 110 to 170 GHz
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• G - 140 to 220 GHz

• Y - 170 to 260 GHz

• J - 220 to 325 GHz

Harmonic A user defined frequency band. Limits are −50 to −1 or 1 to 50.

Mixer Bias Turns on/off the mixer bias and adjusts an internal bias source for use with 
external mixers. The bias signal is present on the center conductor of the IF INPUT 
connector on the front panel.

Bias Level Sets the bias level. Limits are −10 mA to 10 mA.
Calibration
Accesses the Align system and immediately executes an alignment cycle of all the 
subsystems (Align RF, Align IF, Align ADC, and Align Current Sys Gain). The instrument will 
change any current system settings currently underway, perform the full alignment, and 
then return to the current system settings that were in place before the calibration began.

A calibration nominally takes 35 seconds to perform. 

The N8201A downconverter will meet its specifications when:

• It is stored a minimum of two hours within the operating temperature range and turned 
on for at least 30 minutes followed by a calibration.

• When a calibration has been performed within the past 24 hours or when the 
temperature changes 3 °C.

• The front panel 1st LO OUT connector is terminated with a 50 ohm load.
Events (Settling Events and Event Logging)
Settling Event

Allows you to define the parameters of the Settling Event. The Settling Event has a positive 
edge when the frequency is set and a negative edge when the system is stabilized.

Settling Channel

Selects the channel to configure. Possible values are:
LXI0 LXI1 LXI2 LXI3

LXI4 LXI5 LXI6 LXI7

LAN0 LAN1 LAN2 LAN3

LAN4 LAN5 LAN6 LAN7
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Settling Mode 

Selects the operating mode for the Settling Channel: Disabled, Driven, or Wired OR. 

Wired OR is only available for LXI channels.Use Wired OR if more than one instrument is 
driving the LXI channel. When only one instrument is driving the LXI channel then use the 
Driven mode.

Settling Destination Path

The target of the LAN event. The Settling Destination Path can be either an IP address, a 
hostname, or 'All'. (The function is only visible if Settling Channel is a LAN channel and can 
be set if the Settling mode is not Disabled.)

Settling Slope

Determines whether an event will occur on positive or negative edges. Possible values are: 
Positive or Negative.
NOTE  Settling mode must be enabled for Settling Slope to be set.
Execute Settling Event

Starts a settling event after all of the parameters are define.
Event Logging
When enabled, a history of all instrument errors and messages are displayed.

Enable Logging

Enables or disables event logging.

Event Log

Displays the event log in the right pane when the Event Log page is selected.

Clear Event Log 

Clears the event log.

Disable All Events

Prevents any previously events from occurring.
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Sets the instrument to a known state and clears any current settings.
Refresh All Values
Re-reads the settings from the instrument. 
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Front and Rear Panel Features

“N8201A Performance Downconverter Front Panel Features" on page 80

“N8201A Performance Downconverter Rear Panel Features" on page 85

“Interconnect Cabling" on page 87

“Operational Considerations" on page 88
CAUTION Electrostatic discharge (ESD) can damage the highly sensitive components in your 
instrument. ESD damage is most likely to occur as the instrument is being installed 
or when cables are connected and disconnected. Protect the circuits from ESD 
damage by wearing a grounding strap that provides a high resistance path to 
ground. Alternately, ground yourself to discharge any static charge built-up by 
touching the outer shell of any grounded instrument chassis before touching the 
port connectors.
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Option V7L

Option 219
Figure 10 N8201A performance downconverter front panel features
RF INPUT
The input for an external 3 Hz to 26.5 GHz RF signal. If AC Coupled, the range is  
20 MHz to 26.5 GHz.
Power

CAUTION The total power of all signals at the downconverter input must not exceed +30 dBm 
(1 watt).
The front panel power switch is a standby switch only; it is not a LINE switch (power 
disconnecting device). When in Standby, the LED is amber, When ON the LED is green.
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The power indicator has the following states:

The green LED indicates when the downconverter standby switch is set to the on position. 
The green LED is off when the switch is in the standby position. 

The yellow LED indicates when the downconverter standby switch is set to the standby 
position. The yellow LED is off when the switch is in the on position 

State Power Status Illumination

OFF No power connected to rear panel None

Standby Standby power. This is not a LINE 
switch or power disconnecting device.

Solid amber

ON Power is on Solid green
LAN LED
The LAN LED indicator works in the following states:

State of the LAN LAN Status Illumination

ON Normal operation Solid green

ON Device identity. Blinking green

OFF LAN error fault:
• No valid or duplicate IP address
• Unable to obtain or renew previously 

obtained DHCP lease.
• Disconnected LAN cable

Solid Red

OFF This is the state when:
• The system is initializing
or
• A LAN reset has be initialized

None
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The IEEE 1588 LED clock status has the following states:

State of the Clock Clock Status Illumination

OFF Not synchronized None

ON Synchronized, clock is IEEE 1588 Slave Solid green

ON Synchronized, clock is IEEE 1588 Master Blinking green (once 
every second)

ON Synchronized, clock is IEEE 1588 to 
Grand Master

Blinking green (once 
every two seconds

OFF IEEE 1588 is in a fault state Solid red
COHERENT CARRIERS

NOTE Do not remove the cables connecting the coherent carrier inputs and outputs. These cables 
are connected at the factory and must remain so for proper instrument operation.
3-7 GHz 1st LO In Provides the 1st LO input signal (3 to 7 GHz) to the downconverters 
internal LO distribution circuitry.

3-7 GHz 1st LO Out Provides the 1st LO output signal (3-7 GHz at +15 dBm max) as a 
coherent carrier reference for phase locking two receivers.

3.6 GHz 2nd LO In Provides the 2st LO input signal (3.6 GHz) to the downconverters 
internal LO distribution circuitry.

3.6 GHz 2nd LO Out Provides the 2nd LO output signal (3.6 GHz at +3 dBm) as a 
coherent carrier reference for phase locking two receivers.
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1st LO Out The 1st LO output (3-7 GHz at +15 dBm max) allows connections for external 
mixing. The 1st LO output routes the internal first LO signal to an external mixer, which uses 
the higher harmonics to mix with the high frequency signals. The external mixer’s IF output 
connects to the downconverter’s IF input port.

Pre-Sel Out The Preselected external mixer tune output offers tuning voltage for a 
preselected mixer.

IF In (Option AYZ) The IF input (321.4 MHz Nominal at -20 dBm, +10 dBm max) allows 
connections for external mixing. This port is only functional when Option AYZ is ordered.
IF OUTPUTS
321.4 MHz The 321.4 MHz IF output signal is present. Conversion gain is nominally +2 to 
+4 dB (with 0 dB input attenuation). Conversion gain varies nominally ±3 dB as a function 
of tune frequency. The conversion gain drops at higher frequencies.

21.4 MHz The 21.4 MHz IF output signal is present. Conversion gain is nominally  
+10 dB (with 0 dB input attenuation). The conversion gain drops at higher frequencies.

7.5 MHz The 7.5 MHz IF output signal is present. The 7.5 MHz output signal is at 
nominally at +13 dBm.
TRIGGERS
These SMB trigger input and output connectors are used to control the waveforms and 
create event-based signal simulation. These connectors support LVTTL logic levels.

In allows external triggering of measurements.

Out used to synchronize other test equipment with the downconverter. 
REFERENCES
1 - 30 MHz In Selects an external reference to phase lock all oscillators in the 
instrument. You can select any external reference frequency between 1 and 30 MHz.

10 MHz Out A switched output of the analyzer’s internal 10 MHz reference signal locks 
other test equipment to the same frequency reference used by the downconverter. The 
10 MHz out signal is at +5 dB.
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321.4 MHz In

Connector SMB male

Impedance of 50 ohm (nominal)

Video Out

Connector SMB male

Impedance of 50 ohm (nominal)

Maximum input power +10 dBm
NOISE SOURCE +28 V (PULSED) (Option 219)
Connector BNC female

Output voltage On 28.0 +/- 0.1 V (60 mA maximum)

Off < 1 V
VGA OUT
Connector VGA compatible, 15-pin mini D-SUB

Format VGA (31.5 kHz horizontal, 60 Hz vertical sync rates, non-interlaced) Analog RGB

Resolution 640 x 480
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N8201A Performance Downconverter Rear Panel Features
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Figure 11 N8201A performance downconverter rear panel features
AC Power Receptacle
The AC voltage is connected here. The power cord receptacle accepts a 
three-pronged power cable that is shipped with the synthetic downconverter. The 
voltage range is 100/120/220/240 volts with a frequency range of 50 to 60 Hz and is 
automatically selected by the power supply.
LAN
This LAN interface allows ethernet local area network communication through a 100BaseT 
LAN cable.
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The LXI (LAN eXtensions for Instrumentation) Trigger Bus is a hardware bus providing eight 
trigger channels using M-LVDS (low-voltage differential signaling). Cables connect various 
instruments together in a daisy chain or star configuration. Any instrument in a cluster can 
send or receive triggers on any of the channels.
NOTE For more information about the LXI Trigger Bus and LAN triggering, refer to the following 
“LXI Consortium” white papers on your “Agilent N8201A Performance Downconverter 
Documentation CD”:

• White_Paper_1_The_Appliaction_of_IEEE_1588_to_Test_and_Measurement_System
• White_Paper_2_LXI_Triggering
• White_Paper_3_Wired_Trigger_Bus_Physical_Aspects
USB

This is not a functional connector.

DB-9 (TEST)

This connector is for factory testing only.

Trigger Bus Terminators

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Star Hub

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger Bus Terminators

Star Daisy-chain 
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Figure 12 Interconnect cabling for the N8221A IF digitizer/N8201A performance downconverter

1 - 30 M Hz In 10 M Hz Out 300 M Hz
1 2 3
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In Out
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1st LO Out
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This section includes instructions for configuring a LAN interface to the 
Agilent Technologies N8221A IF digitizer and the N8201A performance downconverter. The 
instructions assume that the computer being used has a LAN card installed and is 
configured for TCP/IP protocol. 
Agilent 89601A Vector Signal Analysis Software
The Agilent Technologies 89601A vector signal analysis (VSA) software is the virtual 
instrument interface for the N8221A IF digitizer/N8201A performance downconverter and 
offers a wide range of troubleshooting tools for analyzing signals.
Configuring the Local Area Network (LAN) Interface
You must ensure that the IP addresses for your computer and 
N8221A IF digitizer/N8201A performance downconverter are compatible, then configure 
the LAN interface. The IP address consists of four groups of numbers separated by periods 
(for example 169.254.xxx.xxx).
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Preventive Maintenance

“Using, Inspecting, and Cleaning RF Connectors" on page 90”

“General Procedures and Techniques" on page 93

“Instrument Removal" on page 96”

“Instrument Installation" on page 98

This chapter provides preventative maintenance information, which should be reviewed 
prior to working with the Agilent system. This information applies to all Agilent-supplied 
instruments in the system and the system as a whole.
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Taking proper care of cables and connectors will protect your system’s ability to make 
accurate measurements. One of the main sources of measurement inaccuracy can be 
caused by improperly made connections or by dirty or damaged connectors.

The condition of system connectors affects measurement accuracy and repeatability. Worn, 
out-of-tolerance, or dirty connectors degrade these measurement performance 
characteristics. 
Repeatability
If you make two identical measurements with your system, the differences should be so 
small that they will not affect the value of the measurement. Repeatability (the amount of 
similarity from one measurement to another of the same type) can be affected by:

• Dirty or damaged connectors

• Connections that have been made without using proper torque techniques (this applies 
primarily when connectors in the system have been disconnected, then reconnected).
RF Cable and Connector Care

CAUTION Static-Sensitive Devices 
This system contains instruments and devices that are static-sensitive. Always take 
proper electrostatic precautions before touching the center conductor of any 
connector, or the center conductor of any cable that is connected to any system 
instrument. Handle instruments and devices only when wearing a grounded wrist or 
foot strap. When handling devices on a work bench, make sure you are working on 
an anti-static worksurface.
Connectors are the most critical link in a precision measurement system. These devices are 
manufactured to extremely precise tolerances and must be used and maintained with care 
to protect the measurement accuracy and repeatability of your system.

To extend the life of your cables or connectors:

• Avoid repeated bending of cables—a single sharp bend can ruin a cable instantly.

• Avoid repeated connection and disconnection of cable connectors. 

• Inspect the connectors before connection; look for dirt, nicks, and other signs of damage 
or wear. A bad connector can ruin the good connector instantly.

• Clean dirty connectors. Dirt and foreign matter can cause poor electrical connections 
and may damage the connector.

• Minimize the number of times you bend cables.

• Never bend a cable at a sharp angle.
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• Do not bend cables near the connectors.

• If any of the cables will be flexed repeatedly, buy a back-up cable. This will allow 
immediate replacement and will minimize system down time.

Before connecting the cables to any device:

• Check all connectors for wear or dirt. 

• When making the connection, torque the connector to the proper value.
Proper Connector Torque
• Provides more accurate measurements

• Keeps moisture out of the connectors

• Eliminates radio frequency interference (RFI) from affecting your measurements

The torque required depends on the type of connector. Refer to Table 4.  
Never exceed the recommended torque when attaching cables.

Table 4 Proper Connector Torque

Connector Torque cm-kg Torque N-cm Torque in-lbs Wrench P/N

Type-N 52 508 45 hand tighten

3.5 mm 9.2 90 8 8720-1765

SMA 5.7 56 5 8710-1582
Connector Wear and Damage
Look for metal particles from the connector threads and other signs of wear (such as 
discoloration or roughness). Visible wear can affect measurement accuracy and 
repeatability. Discard or repair any device with a damaged connector. A bad connector can 
ruin a good connector on the first mating. A magnifying glass or jeweler’s loupe is useful 
during inspection.
SMA Connector Precautions
Use caution when mating SMA connectors to any precision 3.5 mm RF connector. SMA 
connectors are not precision devices and are often out of mechanical tolerances, even 
when new. An out-of-tolerance SMA connector can ruin a 3.5 mm connector on the first 
mating. If in doubt, gauge the SMA connector before connecting it. The SMA center 
conductor must never extend beyond the mating plane.
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1 Blow particulate matter from connectors using an environmentally-safe aerosol such as 
Aero-Duster. (This product is recommended by the United States Environmental 
Protection Agency and contains tetrafluoroethane. You can order this aerosol from 
Agilent (see Table 5).)

2 Use alcohol and a lint-free cloth to wipe connector surfaces. Wet a small swab with a 
small quantity of alcohol and clean the connector with the swab. 

3 Allow the alcohol to evaporate off of the connector before making connections.
CAUTION Do not allow excessive alcohol to run into the connector. Excessive alcohol entering 
the connector collects in pockets in the connector’s internal parts. The liquid will 
cause random changes in the connector’s electrical performance. If excessive 
alcohol gets into a connector, lay it aside to allow the alcohol to evaporate. This may 
take up to three days. If you attach that connector to another device it can take 
much longer for trapped alcohol to evaporate.
Table 5 Cleaning Supplies Available from Agilent

Product Part Number

Aero-Duster 8500-6460

Isopropyl alcohol 8500-5344

Lint-Free cloths 9310-0039

Small polyurethane swabs 9301-1243
WARNING Cleaning connectors with alcohol should only be performed with the 
instruments’ mains power cord disconnected, in a well ventilated area. 
Connector cleaning should be accomplished with the minimum amount of 
alcohol. Prior to connector reuse, be sure that all alcohol used has dried, and that 
the area is free of fumes.

WARNING If flammable cleaning materials are used, the material should not be stored, or 
left open in the area of the equipment. Adequate ventilation should be assured to 
prevent the combustion of fumes, or vapors.
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This section introduces you to the various cable and connector types used in the system. 
Read this section before attempting to remove or install an instrument! Each connector 
type may have unique considerations.

Always use care when working with system cables and instruments.
Figure 13 GPIB, 3.5 mm, Type-N, power sensor, and BNC connectors

GPIB Type Connector
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GPIB connectors

These are removed by two captured screws, one on each end of the connector; these 
usually can be turned by hand. Use a flathead screwdriver if necessary.

GPIB connectors often are stacked two or three deep. When you are removing multiple 
GPIB connectors, disconnect each connector one at a time. It is a good practice to connect 
them back together even if you have not yet replaced the instrument; this avoids confusion, 
especially if more than one instrument has been removed.

When putting GPIB connectors back on, you must again detach them from one another and 
put them on one at a time.

Precision 3.5 mm connectors

These are precision connectors. Always use care when connecting or disconnecting this 
type of connector. When reconnecting, make sure you align the male connector properly. 
Carefully join the connectors, being careful not to cross-thread them. 

Loosen precision 3.5 mm connectors on flexible cables by turning the connector nut 
counter-clockwise with a 5/16 inch wrench. Always reconnect using an 8 inch-lb torque 
wrench (Agilent part number 8720-1765). Semirigid cables are metal tubes, custom-formed 
for this system from semirigid coax cable stock.

3.5 mm connectors with a gold hex nut

The semirigid cables that go to the RF outputs of some devices have a gold connector nut. 
These do not turn. Instead, the RF connector on the instrument has a cylindrical connector 
body that turns. To disconnect this type of connector, turn the connector body on the 
instrument clockwise. This action pushes the cable’s connector out of the instrument 
connector. 

To reconnect, align the cable with the connector on the instrument. Turn the connector 
body counterclockwise. You may have to move the cable slightly until alignment is correct 
for the connectors to mate. When the two connectors are properly aligned, turning the 
instrument’s connector body will pull in the semirigid cable’s connector. Tighten firmly by 
hand.

3.5 mm connectors with a silver hex nut

All other semirigid cable connectors use a silver-colored nut that can be turned. To remove 
this type of connector, turn the silver nut counter-clockwise with a 5/16 inch wrench.

When reconnecting this type of cable:

• Carefully insert the male connector center pin into the female connector. (Make sure the 
cable is aligned with the instrument connector properly before joining them.)
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• Turn the silver nut clockwise by hand until it is snug, then tighten with an 8 inch-lb 
torque wrench (part number 8720-1765).

Bent Semirigid Cables

Semirigid cables are not intended to be bent outside of the factory. An accidental bend that 
is slight or gradual may be straightened carefully by hand. Semirigid cables that are crimped 
will affect system performance and must be replaced. Do not attempt to straighten a 
crimped semirigid cable.
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To remove an instrument from the system, use one of the following procedures.

Required tools

• #2 Phillips screwdriver

• #2 POZIDRIV screwdriver
Standard instrument
To remove an instrument from a rack

Step Notes

1 Turn off system power, but leave the system 
computer turned on. 

• If you do plan to turn computer power off 
for any reason, have the computer system 
administrator:

• Shut down all running software.
• Shut down the computer.

2 Read “General Procedures and Techniques”, 
then disconnect all cables on the front and on 
the rear panel.

• Most cables are fairly easy to remove and 
reconnect, and have no special 
considerations (besides making sure you 
put the cables back in the right place). 

• Semirigid cables require more care, 
especially when reconnecting them. Make 
sure all semirigid cables, on the front and 
back of an instrument are fully 
disconnected before removing the unit.

3 When all cables are disconnected (including 
the power cord), remove the screws in the 
instrument’s rack “ears” that hold it in the 
rack. 

4 Slide the instrument out. • If you feel any resistance when attempting 
to pull the instrument out, STOP! Look 
inside the cabinet and carefully examine 
all surrounding cables. Make sure all 
cables are fully disconnected.
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To remove a half-width instrument from a system rack 

1 Power off the system. • For details see the system installation 
guide. 

2  Remove the selected instrument’s power cord 
from the power strip in the rack.

3 The instrument is attached to the half-rack width 
instrument beside it; remove that instrument’s 
power cord from the power strip also.

• The instruments are secured together 
by lock links at the front and rear. The 
lock links at the rear attach with screws. 
The lock links at the front hook together. 

4 Remove the power cord and other cables from the 
front and rear of both instruments.

• Note the location of cables for 
re-installation.

5 Remove the four corner screws on the front of the 
rack panel that secures the instruments in place.

• The screws are located near the corners 
of the face of the instrument.

• Use a #2 Phillips screwdriver.

6 Slide both instruments, as a single unit, out from 
the front of the rack and set them on a secure, flat 
surface.
Bench Top Instrument
To remove an instrument from a bench top system 

1 Power off each instrument in the system.

2  Unplug the selected instrument’s power 
cord from the AC power supply.

3 Remove the power cord and other cables 
from the front and rear of the instrument.

• Note the location of cables for re-installation.
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Instrument Installation
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To install or reinstall an instrument in a system, use one of the following procedures.

Required tools

• #2 Phillips screwdriver

• #2 POZIDRIV screwdriver

• system installation guide
Standard rack instrument
To install an instrument

Step Notes

1 Slide the instrument gently into the rack.

2 Insert the screws in the rack ears. • Most cables are fairly easy to remove and 
reconnect and have no special 
considerations (besides making sure you 
put the cables back in the right place). 

• Semirigid cables require more care, 
especially when reconnecting them. Make 
sure all semirigid cables, on the front and 
back of an instrument are fully 
disconnected before removing the unit.

3 To reconnect the semirigid cables, carefully 
align them before you insert the male 
connector. 

• Do not insert the male pin in at an angle or 
you will damage the female connector. RF 
connector center pins are very delicate, 
and if damaged must be replaced. System 
performance may be greatly impaired if 
there is a bad RF connector.

4 Turn on system power and restart the system 
computer if necessary.
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To install the instrument in a rack 

Step Note

1 Make sure the system is powered off.

2 Insert the attached instruments in the same 
slot from which you removed them, sliding 
them along the support rails until they meet 
the rack-mount ears.

• The rack-mount ears stop the instruments at 
the correct depth.

3 Replace the rack panel in front of the 
instruments and secure the four corner 
screws.

• The screws are located near the corners of 
the face of the instrument.

• Use a #2 Phillips screwdriver.

4 Confirm that the instrument is turned off.

5 Connect the appropriate cables to the 
instruments (front and rear), including the 
power cords.

6 Power on the system. . 
Bench Top Instrument
To install an instrument in a bench top system 

1 Make sure the system is powered off.

2 Connect all cables to the instrument (front 
and rear), including the power cord.

3  Connect the power cord to the AC power 
source.

4 Power on the system.

5 Set the instrument GPIB address, if 
necessary.
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6
Service, Support, and Safety 
Information

“Safety and Regulatory Information" on page 102”

“Service and Support" on page 109

This chapter provides safety and regulatory information that should be reviewed prior to 
working with the Agilent system. The information contained in this chapter applies to all 
Agilent-supplied instruments in the system and the system as a whole.

It also contains information on servicing and obtaining support for an Agilent system or 
instrument, including procedures for removing an instrument from a system, returning it to 
Agilent, and reinstalling it.
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Safety and Regulatory Information

EMC
102
Complies with European EMC Directive 89/336/EEC, amended by 93/68/EEC

• IEC/EN 61326

• CISPR Pub 11 Group 1, Class A

• AS/NZS CISPR 11:2002

• ICES/NMB-001

Complies with Canadian EMC Requirements

This ISM device complies with Canadian ICES- 001

Cet appareil ISM est conforme a la norme NMB du Canada.
Safety
Complies with European Low Voltage Directive 73/23/EEC, amended by 93/68/EEC

• IEC/EN 61010-1

• Canada: CSA C22.2 No. 61010-1

• USA: UL 61010-1
Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument or system. Failure to comply with these precautions or with specific 
warnings elsewhere in this manual violates safety standards of design, manufacture, and 
intended use of this instrument or system. Agilent Technologies, Inc. assumes no liability 
for the customer’s failure to comply with these requirements.

General

This product has been designed and tested in accordance with the standards listed on the 
Manufacturer’s Declaration of Conformity, and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed by the user to 
ensure safe operation and to maintain the product in a safe condition. Contact your Agilent 
sales representative to obtain a copy of the Declaration of Conformity. Alternately, contact 
Agilent via: www.Agilent.com.

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation on 
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung 
-3.GSGV Deutschland.)
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Acoustic Noise Emission/Geraeuschemission

LpA <70 dB
Operator position
Normal position
per ISO 7779

LpA <70 dB
am Arbeitsplatz
normaler Betrieb
nach DIN 45635 t.19
Agilent N8201A Perfo
All light-emitting diodes (LEDs) used in this product are Class 1 LEDs per IEC 60825-1.
Equipment Installation
Install the instrument or system so that the detachable power cord is readily identifiable 
and is easily reached by the operator. The detachable power cord is the disconnecting 
device. It disconnects the mains circuits from the mains supply before other parts of the 
instrument or system. The instrument front panel switch is only a standby switch and is not 
a LINE switch. Alternatively, an externally installed switch or circuit breaker (which is 
readily identifiable and is easily reached by the operator) may be used as a disconnecting 
device.
WARNING This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall be inserted only in a socket 
outlet provided with a protective earth contact. Any interruption of the protective 
conductor inside or outside of the product is likely to make the product 
dangerous. Intentional interruption is prohibited (IEC 348 clauses 17.3.3 c and 
17.3.4).

WARNING DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE. 
Do not operate the instrument or system in the presence of flammable gases or 
flames.

WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the same 
or equivalent type recommended. Discard used batteries according to 
manufacturer’s instructions.
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Environmental Conditions

Before Applying Power

WARNING DO NOT REMOVE AN INSTRUMENT COVER.

Operating personnel must not remove instrument covers. Component 
replacement and internal adjustments must be made only by qualified service 
personnel.

Instruments that appear damaged or defective should be made inoperative and 
secured against unintended operation until they can be repaired by qualified 
service personnel.

WARNING If this product is not used as specified, the protection provided by the equipment 
could be impaired. This product must be used only in a normal condition (in which 
all means for protection are intact).

CAUTION Unless otherwise noted in the specifications, this instrument or system is intended 
for indoor use in an installation category II, pollution degree 2 environment per IEC 
61010 second edition and 664 respectively. This instrument or system is designed 
to operate at altitudes up to 4600 meters, and at temperatures between 0°C and 
55 °C.

CAUTION Ventilation Requirements: When installing the product in a cabinet, the convection 
into and out of the product must not be restricted. The ambient temperature 
(outside the cabinet) must be less than the maximum operating temperature of the 
product by 4 °C for every 100 watts, then forced convection must be used.

CAUTION Verify that the product is set to match the available line voltage, the correct-rating 
service breaker is installed, the correct fuse is installed, and all safety precautions 
are taken. Note the instrument external markings described in Table 6, “Safety symbols 
and instrument markings,” on page 107.

Position the instrument so that it is not difficult to operate the disconnecting device.

This instrument has autoranging line voltage input, be sure the supply voltage is 
within the specified range.
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Magnetic Susceptibility

Vibration

Ground the Instrument or System

WARNING The mains wiring and connectors shall be compatible with the connector used in 
the premise electrical system. Failure to ensure adequate earth grounding by not 
using the correct components may cause product damage and serious injury.

CAUTION Degradation of some product specifications can occur in the presence of ambient 
power frequency magnetic fields of 30 A/m or greater. The product self-recovers 
and operates as specified when removed or shielded from the ambient magnetic 
fields.

CAUTION Degradation of some product specifications can occur if this instrument is operated 
while subjected to continuous vibrations of less than or equal to 0.21 grms in the  
5 Hz to 500 Hz frequency range.

WARNING To minimize shock hazard, the instrument chassis and cover must be connected 
to an electrical protective earth ground. The instrument and/or system must be 
connected to the AC power mains through a grounded power cable, with the 
ground wire firmly connected to an electrical ground (safety ground) at the 
power outlet. Any interruption of the protective (grounding) conductor or 
disconnection of the protective earth terminal will cause a potential shock 
hazard that could result in personal injury.

WARNING This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall be inserted only in a socket 
outlet provided with a protective earth contact. Any interruption of the protective 
conductor inside or outside of the product is likely to make the product 
dangerous. Intentional interruption is prohibited (IEC 348 clauses 17.3.3 c and 
17.3.4).

CAUTION Always use the three-prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product damage.
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Fuses and Circuit Breakers

CAUTION The detachable power cord is the disconnecting device. It disconnects the mains 
circuit from the mains supply before other parts of the instrument or system. The 
instrument front panel switch is only a standby switch and is not a line switch.
106
Refer to individual instrument manuals for detailed information on operator accessible 
fuses.
WARNING Use only fuses with the required rated current, voltage, and specified type 
(normal blow, time delay). Do not use repaired fuses or short-circuited fuse 
holders. To do so could cause a shock or fire hazard.

WARNING For continued protection against fire hazard, replace fuses and circuit breakers 
only with the same type and ratings. The use of other fuses or circuit breakers or 
materials is prohibited (IEC 348 clause 17.3.5.d).

WARNING The premise wiring should have a system-dedicated circuit breaker in the mains 
wiring for installation of the system.
Agilent system cabinet power strips are equipped with a thermal circuit breaker for each 
power phase. If one phase shorts or overloads, one or both of the circuit breakers in the 
power strip trip. Unplug the power strip before trying to locate and correct the electrical 
problem, then reset both circuit breakers on the power strip to restore power to the cabinet.
Maintenance

Safety symbols and Instrument Markings

WARNING To prevent electrical shock, disconnect the instrument and/or system from 
mains before cleaning. Use a dry cloth or one slightly dampened with water to 
clean the external case parts. Do not attempt to clean internally.
Symbols and markings in manuals and on instruments alert you to potential risks, provide 
information about conditions, and comply with international regulations. Table 6 defines the 
symbols and markings you may find in a manual or on an instrument.
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Table 6 Safety symbols and instrument markings 

Safety symbols Definition

Warning: risk of electric shock.

Warning: hot surface.

Caution: refer to instrument documentation.

The CE mark is a registered trademark of the European 
Community. 

The CSA mark is a registered trademark of the 
CSA-International. This instrument is in compliance with CSA 
1010 Edition2.

The C-tick mark is a registered trademark of the Spectrum 
Management Agency of Australia. This signifies compliance 
with the Australian EMC Framework regulations under the 
terms of the Radio Communications Act of 1992.

This symbol indicates separate collection for electrical and 
electronic equipment, mandated under EU law as of August 13, 
2005. all electric and electronic equipment are required to be 
separated from normal waste for disposal (Reference WEEE 
Directive, 200/96/EC).

ISM1-A This text indicates that the instrument is an Industrial Scientific 
and Medical Group 1 Class A product (CISPER 11, Clause 4).

ICES/NMB-001 This text indicates product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

Laser radiation symbol: marked on products that have a laser 
output.

Alternating current.

Both direct and alternating current.

Three-phase alternating current.

Earth (ground) terminal.

Protective earth (ground) terminal.

Frame or chassis terminal.

N10149
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Terminal is at earth potential. Used for measurement and 
control circuits designed to be operated with one terminal at 
earth potential.

Terminal for neutral conductor on permanently installed 
equipment.

Terminal for line conductor on permanently installed 
equipment.

Standby (supply); units with this symbol are not completely 
disconnected from AC mains when this switch is in the standby 
position. To completely disconnect the unit from AC mains, 
either disconnect the power cord, or have a qualified/licensed 
electrician install an external switch.

OFF (supply); a switch with this symbol opens the instrument’s 
power supply circuit, disconnecting it with the mains supply.

ON (supply); a switch with this symbol closes the instrument’s 
power supply circuit, connecting it with the mains supply.

Table 6 Safety symbols and instrument markings (continued)

Safety symbols Definition
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Service and Support
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Any adjustment, maintenance, or repair of this product must be performed by qualified 
personnel. Contact your Agilent Technologies Service Center for assistance. 
Agilent on the Web

WARNING There are no user serviceable parts inside the system. Any servicing instructions 
are for use by qualified personnel only. To avoid electrical shock, do not perform 
any servicing unless you are qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose dangerous voltages. 
Disconnect the product from all voltage sources while it is being opened.

CAUTION Any operator-replaceable parts or supplies are required to be examined or supplied 
by Agilent Technologies.
You can find information about technical and professional services, product support, and 
equipment repair and service on the Web:

http://www.agilent.com 

Click on Technical Support.
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Return Procedure
110
In any correspondence or telephone conversations with Agilent Technologies, please refer 
to the instrument by its model number (N8201A, for example) and serial number. With this 
information, the customer engineer can determine whether your instrument is still within 
its warranty period and provide accurate shipping information.
Shipping the Instrument
Use the following procedure to package and ship your instrument for service. For 
instructions on removing an instrument from the system and re-installing it, refer to the 
system user’s guide.

To package the instrument for shipping 

Step Notes

1 Place the instrument in its original packaging 
materials.

• If the original packaging materials are 
not available, use a professional 
packaging service. Contact your Agilent 
Service Center for more information.

2 Surround the instrument with at least 3 to 4 
inches of its original packing material or 
bubble-pack to prevent the instrument from 
moving in its shipping container.

3 After wrapping it with packing material, place the 
instrument in its original shipping container or a 
strong shipping container that is made of 
double-walled corrugated cardboard with 159 kg 
(350 lb) bursting strength.

• The shipping container must be large 
and strong enough to accommodate 
your instrument and allow at least 3 to 4 
inches on all sides for packing material.

4 Seal the shipping container securely with strong 
nylon adhesive tape.

5 Mark the shipping container “FRAGILE, HANDLE 
WITH CARE” to help ensure careful handling.

6 Use the address obtained from your Agilent 
customer engineer.

7 Retain copies of all shipping papers.
CAUTION Damage can result if the original packaging materials are not used. Packaging 
materials should be anti-static and cushion the downconverter on all sides. NEVER 
USE STYRENE PELLETS IN ANY SHAPE AS PACKAGING MATERIALS. They do not 
adequately cushion the instrument or prevent it from moving in the shipping 
container. Styrene pellets can also cause equipment damage by generating static 
electricity or by lodging in fan motors.
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Auto-IP Auto-IP is a method used by a device to self select an IP address. When a device 
is using Auto-IP, it randomly selects an address of the form 169.254.x.x. If another 
device is already using that address, it selects another random address, and continues to 
select new addresses until it finds one that is not being used by any other instrument.

Cross-Over Cable A cross-over cable can be used to connect two devices directly to 
each other, without a network switch or any other hardware in-between. It is common to 
use static IP addresses when devices are connected using a cross-over cable, because 
there is no DNS, and there are no other devices on the connection that could cause an IP 
address conflict.

Default Gateway The default gateway is used by a device to communicate with devices 
that have IP addresses that are on different subnets. This would usually be the IP address 
of the router that connects the device’s subnet to the rest of the network.

DHCP [Dynamic Host Configuration Protocol] In order to avoid IP address conflicts, 
and to simplify the process of connecting devices to a network, larger networks will 
sometimes use DHCP to assign IP addresses to devices.

When a device is configured to use DHCP, it attempts to communicate with the DHCP 
server when it is powered on. If it is able to communicate with the server, it asks the server 
for the correct network settings (including IP Address, Subnet Mask, Gateway, and so on) 
to communicate on the network. If the device is unable to communicate with the DHCP 
server, it will either go into a failure mode, or (if configured to do so) it will attempt to assign 
itself an IP address. (See Auto-IP)

Because the IP address assigned to an instrument can be different every time it is powered 
on, you cannot remember the IP address and expect to always be able to use that address 
to communicate with the instrument. However, networks using DHCP will often also use 
DNS, which can allow you to communicate with a device using a hostname that will stay 
the same, even if the device’s IP address has changed.

DHCP Server The DHCP server responds to devices’ requests for network settings. It is 
responsible for ensuring that no two devices attempt to use the same IP address.
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DNS [Domain Name Server] A domain name server allows someone to communicate 
with a device using the device’s hostname. When a device joins a network, it tells the 
domain name server its hostname and its IP address. When a hostname is used, the domain 
name server is asked which IP address the name corresponds to, and that address is then 
used to communicate with the instrument. 

If the IP address of the device changes, it can request that its entry in the domain name 
server be updated. Any following requests that use the same hostname as before, will be 
sent to the new address.

Hostname A hostname is a unique name that can be used to communicate with a device 
on a network. Hostnames are commonly used in situations where devices have their 
addresses assigned to them using DHCP.

Hostnames can only be used if there is some way that the network can keep track of which 
hostname corresponds to an instrument. This is usually done using DNS. 

Networks without DNS have no way to associate a hostname with a device. This is often 
true of small private LAN networks (for example, a network consisting of two devices 
connected using a cross-over cable, or through a simple router). In these cases, it is 
probably easiest to use static IP addresses.

IP Address [Internet Protocol Address] An IP address is a unique number assigned to 
a device which is used to send or receive data to and from other devices.

The most common IP addresses are IP Version 4. These addresses are usually written as 
four numbers (from 1 to 255) separated by periods. For example, 192.168.1.1 and 
169.254.12.34 and 141.121.84.241 are all IP addresses.

A device’s IP address can be assigned to it manually (See Static IP Address), assigned to it 
by another computer (See DHCP) or can be self-determined (See Auto-IP).

IP Address Conflict An IP address conflict occurs when two devices attempt to join the 
same network with the same IP address. When this happens, it may become impossible to 
communicate with either instrument over the LAN. Using dynamically assigned addresses 
can help avoid this problem. (See DHCP or Auto-IP.)

LAN [Local Area Network] A LAN is a network of devices connected to each other 
using LAN cables and network switches.

Network Switch A network switch is used to connect several devices together to form a 
LAN. It has several LAN ports that LAN cables can be connected to.

If it is necessary to create a network with more devices than can connect to a single 
network switch, one (or more) switches can be attached to the first switch.

Private LAN  A private LAN network is defined as a local area network in which 
LAN-enabled instruments and Windows PCs are not connected to a site LAN (workgroup 
LAN, Intranet, or enterprise LAN). When using a private LAN, the designer of the LAN is 
responsible for defining all private LAN parameters.
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Private Network All of the devices on a private network use IP addresses that have been 
reserved for private use. The most common private network IP addresses are of the form 
192.168.x.x and 169.254.x.x. Devices which have been assigned a private 
network IP address cannot generally communicate with other devices outside of their 
private network. Many devices can use the same IP address (for example, 
192.168.1.1) as long as they each belong to different private networks.

Router A router can be used to transfer messages between two (or more) networks. 
Routers are often used to connect a private network to a larger network (for example, a 
company network, or the Internet). The router can also be used to isolate a local network 
from a larger corporate or public network.

Site LAN  A site LAN is a local area network in which LAN-enabled instruments and 
Windows PCs are connected to a site LAN (workgroup LAN, Intranet, or enterprise LAN) 
through (optional) routers, hubs, and/or switches.

Static IP Address A device uses a static IP address when it always attempts to use the 
same IP address every time that it is turned on. Using a static IP address can be useful if 
you always want to communicate with an instrument using the same address every time it 
is turned on. However, using a static IP address can lead to IP address conflicts if two 
instruments are given the same static IP address.

Subnet (Subnetwork) A subnet is a group of devices which is a subset of a larger group 
of devices. Breaking a large network down into many smaller subnets can make the 
network easier to manage, and can decrease the amount of traffic that gets sent between 
devices.

One thing a device on a network can do is send a message to all of the other devices on its 
subnet. If a network consists of only a single subnet, that message would have to be sent to 
every device on the network. However, if the network has been broken down into subnets, 
the message would only be sent to other devices on the same subnet as the device sending 
the message.

Subnet Mask A subnet mask is used to specify how a network is broken down into 
subnets. Subnet masks look like IP addresses; they are of the form x.x.x.x. Common 
subnet masks include 255.0.0.0, 255.255.0.0 (use this for private networks), and 
255.255.255.0.

When written in binary, subnet masks usually become several 1s followed by several 0s.

For example: 

255.255.0.0 

would become 

11111111.11111111.00000000.00000000.
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The subnet mask can be used with a device’s IP address to determine the address of the 
subnet that the device is on. To do this, you perform a logical AND of the subnet mask and 
the IP address. (A logical AND combines two binary numbers into a single number. The new 
number contains 1s in positions where both numbers had 1s, and 0s everywhere else.)

For example, if a device has an IP address of 192.168.12.34 and the subnet mask 
255.255.255.0 then:
192.168.12.34 = 11000000. 10101000. 00001100. 00100010

255.255.255.0 = 11111111. 11111111. 11111111. 00000000

Subnet Address = 11000000. 10101000. 00001100. 00000000

192 168 12 0
The device is on the subnet with the 192.168.12.0 address.

A device with the IP address 192.168.12.100 is on the same subnet as the device 
with the IP address 192.168.12.34 (the 192.168.12.0 subnet), but a device with 
an IP address of 192.168.100.34 is on a different subnet (the 192.168.100.0 
subnet).
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